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Getting started

About RoboHelp Server

Adobe RoboHelp Server is a server-based Help solution that provides real-time end-user feedback on your 
Help and knowledge base. RoboHelp Server gathers and logs data about what questions users ask while 
searching content and how users navigate through topics. Results are displayed in an easy-to-view graph-
ical format for quick interpretation. Your Help system resides on a server (for example, Adobe Help 
Resource Center), and you can make instant updates to your Help system content.

RoboHelp Server contains the back-end processes, functionality, and JDBC connections necessary to inte-
grate it. RoboHelp Server works with the authoring tool, so authors can edit content, set master project 
options, maintain windows, and view reports.

RoboHelp Server interaction with different components

NOTE: 
With RoboHelp Server, you can install your database server on a separate machine or use any of the 
existing database servers. 

RoboHelp Server features

Tracking and reporting

Adobe RoboHelp Server provides end users with the ability to find information when they have questions. 
Users can view content using any standard browser and operating system. Any number of users can access 
the published documents.
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NOTE: 
You can define the maximum number of database connections for Oracle and Microsoft SQL Server 
database management systems through the maxload property in the robohelp_server.prop-
erties file. 

RoboHelp Server tracks the following types of data:
• Where users request assistance: Identifies the location where users make repeated requests for specific 

information.
• How users search: Searches that users perform repeatedly. This data can be mined to move frequently 

searched information to a more prominent position in the content for easier access. You can also use 
this information to find information gaps and to improve heading titles for more intuitive navigation.

• How users navigate online content: Tracks how users seek information in online content and how 
frequently they access particular information such as headings and articles. This information is avail-
able at a topic level.

• RoboHelp Server tracks the entire operating system and browser details. You can use this information 
to improve the content quality for browsers preferred by users.

Automatic project merging

Concurrently work on multiple projects and merge them into a single project at run time.

While building an online information system, authors can develop and publish their content according to 
their own schedules. RoboHelp Server provides automatic project merging, so authors can work on 
different parts of a project at the same time, and publish them to the same server. When end users view 
the content, they see one seamless online information system. Do not worry about sharing source or 
depending on a single author or project—all the separate projects are merged when users access the 
content. Users can navigate across all the projects using the Index, Contents, and Search buttons.

By default, projects are added to the Table of Contents in the order they are published to the server. You 
can customize this order in the Projects page of the Web Admin interface. When you merge projects, each 
project file in the authoring tool remains intact, but the keywords from the indexes and glossary terms are 
combined at run time, or when end users access the system from the server.

Support for languages other than English

The runtime interface (including Table of Contents, index, glossary, and search) can be automatically local-
ized, and authors can publish projects written in various languages to the same server. RoboHelp Server 
supports localization for more than 35+ languages, for example, French, German, Italian, Japanese, Korean, 
Turkish, and many more. You can change the display text on the user interface of the online system to 
another language, including text on the Contents, Index, and Search buttons.

In addition, end users can perform a full-text search of online content in their native language. This flexi-
bility allows authors to develop content in languages other than English and take advantage of 
server-based online information systems.
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Resources

Before you begin working with your software, take a few moments to read an overview of activation and 
the many resources available to you. You have access to instructional videos, plug-ins, templates, user 
communities, seminars, tutorials, RSS feeds, and much more.

License activation

During the installation process, your Adobe software contacts an Adobe server to complete the license 
activation process. No personal data is transmitted. For more information on product activation, visit the 
Adobe website at www.adobe.com/go/activation.

Help and support

Understand the various Help resources for you to get started with RHS and other related products like 
RoboHelp.

Community Help

Community Help is an integrated environment on Adobe.com that gives you access to community-gener-
ated content moderated by Adobe and industry experts. Comments from users help guide you to an 
answer. Search Community Help to find the best content on the Web about Adobe products and technol-
ogies, including these resources:
• Videos, tutorials, tips and techniques, blogs, articles, and examples for designers and developers.
• Complete online Help, which is updated regularly and is more complete than the Help delivered with 

your product. If you are connected to the Internet when you access Help, you automatically see the 
latest online Help rather than the set delivered with your product.

• All other content on Adobe.com, including knowledge base articles, downloads and updates, Adobe 
Developer Connection, and more.

Use the Help search field in your product’s user interface to access Community Help. You can search for 
content within the Adobe.com site and also in websites that have useful information about your product. 
Moderators continue to identify most relevant Web content for your product. You can add comments to 
online Help and view comments added by other users. For a video of Community Help, see Adobe 
Community help page.

Other resources

Adobe RoboHelp Server Support page also includes a link to the complete, updated PDF version of Help.

Visit the Adobe Support website at www.adobe.com/support to learn about free and paid technical 
support options.

http://www.adobe.com/support
http://www.adobe.com/go/learn_rhs_support_en
http://www.adobe.com/go/learn_community_help_en
http://www.adobe.com/go/learn_community_help_en
http://www.adobe.com/go/activation
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What’s new in Adobe RoboHelp Server 11

Publishing enhancements

RoboHelp Server now supports Frameless output along with Responsive HTML5 published from the latest 
release of RoboHelp. This is in addition to other enhancements in the areas of project tracking, reporting, 
and merging for various projects.

Enhanced database support

RoboHelp Server supports Apache Derby version 10.14.2 as its default database. You don't have to install 
Apache Derby manually, as RoboHelp Server's installer installs Apache Derby on your system.

Technical enhancements

• Support for JDBC Connectivity - RoboHelp Server uses a database to store usage reports, users and 
group information. Database connection architecture has been enhanced in RoboHelp Server to 
support external databases using JDBC connectivity.

• LDAP sub-container lookup - RoboHelp Server supports integration with LDAP server which enables 
users to login to RoboHelp Server using their LDAP credentials. To integrate RoboHelp Server with 
LDAP, administrator has to provide base search node for users or groups in the LDAP tree. Till Robo-
Help Server 10, only the users or groups which were directly under the specified nodes, could be 
authenticated from RoboHelp Server. Starting from RoboHelp Server 11, all users or groups which are 
in different sub-nodes within the base node can also be authenticated.

• Data Migration from RoboHelp Server 10 - RoboHelp Server 11 supports migration of content from 
RoboHelp Server 10. Migrating an older version of Microsoft SQL or Oracle server database will require 
the user to enter JDBC details for that server. In case you are migrating data from MS Access, then you 
must have MS Access Runtime installed on the destination machine (where RoboHelp Server 11 is 
installed). For more information see Migrate context data.

• Single Sign-On (SSO) authentication – RoboHelp Server supports integration with Active Directory 
Federation Services (ADFS)/OKTA servers, which allows the user to directly login to RoboHelp Server. 
Users can directly login using an active SSO user account, without the need to provide credentials. An 
administrator must provide an authorization API endpoint, token API endpoint, and a few more details 
of the server to integrate RoboHelp Server with LDAP.

• Coordinated Universal Time (UTC) time zone - RoboHelp Server supports storing information in the 
database in the UTC time zone. An optional parameter (TimezoneforRHS), when configured, 
displays information in the UI in a user's local time zone while still allowing database information to 
be stored in UTC time. For more information, see the Time zone configuration.

• ADFS token-based authorization - RoboHelp Server supports token-based permissions to enable inte-
gration between RoboHelp Server and ADFS authorization flow. This allows a user to be authorized 
based on the value entered in the Token Role Key attribute. For more information, see Single Sign-On 
using ADFS.
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Reporting enhancements

RoboHelp Server 11 delivers new and enhanced reports that will help you better optimize the value of your 
Help content

Configuration Manager enhancements

You can now perform the following additional tasks using the RoboHelp Server Configuration Manager:
• Migrate context data from RoboHelp Server 10 to RoboHelp Server 11
• Define JDBC and database settings
• Configure projects storage location of any context, outside the RoboHelp Server installation directory 

using Configuration Manager.
• Import RoboHelp Server 11 setup for any given context using the new Import Settings feature.

NOTE: 
To update contexts, it is no longer required to run the Configuration Manager in Administrator mode 
manually, as in the previous version. The Configuration Manager now runs only with administrative 
privileges. 

Search-related enhancements

Enhanced server-side search indexing is provided in RoboHelp Server 11. In RoboHelp Server Web Admin-
istrator, if the option for merging same type of projects is selected in the Projects tab, then the search items 
will appear aligned as per the projects. The search is now faster and more intuitive.

System requirements

Hardware requirements

• 64-bit 4 vCpu Core i5 or faster processor
• 4 GB (recommended)
• 2 GB of available hard-disk space; additional free space required during installation (cannot install on 

a volume that uses a case-sensitive file system).

Supported operating systems

Adobe RoboHelp Server 11 is supported on 64-bit architecture of the Microsoft Windows operating system.

For Adobe RoboHelp Server 11.5 version supports the following operating systems:
• Windows Server 2022
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• Windows Server 2019
• Windows Server 2016
• Windows 10

For Adobe RoboHelp Server 11.4 and earlier versions support the following operating systems:
• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2

Prerequisites for installing RoboHelp Server 11

• JRE 8
• Apache Tomcat 8 or later

NOTE: 
RoboHelp Server requires Apache Tomcat to run. Tomcat is a servlet container that can also work as 
a Web server. 

• JDBC Drivers (for external database)

NOTE: 
The .jar files given below are just recommendations. 

Supported browsers

• Microsoft Edge
• Mozilla Firefox
• Google Chrome

Oracle19c driver jar file ojdbc8.jar

Oracle12c driver jar file ojdbc7.jar

Oracle11g R2 driver jar file ojdbc6.jar

Microsoft SQL 2008/2012/2014/2017/2019 sqljdbc41.jar (Version 4.1)
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Supported Web servers

You can configure Tomcat with an external Web server. Using an external Web server offers ease and flex-
ibility while configuring settings, such as proxy server and filtering rules. RoboHelp Server supports the 
following Web servers in combination with Tomcat:
• Tomcat 9.0.37
• Tomcat 8.5.0
• Tomcat 8.0.32

Supported database management systems

You can use the built-in Apache Derby database or select an external database to store reports and authen-
tication information for RoboHelp Server. The following external database management systems are 
supported:
• Oracle 19c
• Oracle 12c

• Microsoft SQL Server 2017

Supported databases

RoboHelp Server connects to Apache Derby, Oracle (19c, 12c), Microsoft SQL Server, or Microsoft SQL 
Server Express Edition database management systems.

Apache Derby
It is an open source relational database created in Java. A full-fledged Derby system consists of a system 
directory, zero or more databases, and a system-wide configuration. For RoboHelp Server, the Derby 
system directory is set as <RHS-Install-Path>\database.

Microsoft SQL Server
Microsoft SQL Server is a relational database management system capable of handling large amounts 
of data and many concurrent users. When a client application requests data, the server retrieves or 
updates the data. Microsoft SQL Server can roll back transactions. It does not commit a partially 
entered record to the database.

Oracle
The Oracle database management system provides for the definition, storage, and management of 
data in a centralized area. It supports client-server environments, large databases, space management, 
concurrent database users, high transaction-processing performance, openness, compliance with 
industry standards, manageable security, portability, compatibility, and connectivity.

Microsoft SQL Server Express Edition
Microsoft SQL Server Express Edition is a relational database management system (RDBMS) produced 
by Microsoft. Its primary query languages are MS-SQL and T-SQL.



GETTING STARTED
INSTALLATION

 8

Install a database management system

To install a supported database management system, refer to the relevant documentation given below:

Installation

Installation overview

IMPORTANT 
Before installing RoboHelp Server updates, take a backup of the web.xml file from the 
[RHS-installation-directory]\web-inf folder. After installing the update, replace the 
web.xml file at the same location and then start the server. Context settings will revert to its default on 
failure to copy the web.xml file, which would result in loss of any custom settings that you would have 
made in your existing setup. Also, ensure that any site data, cookies, or cache for the web admin login 
page is cleared for smoother functioning. 

Installing RoboHelp Server involves the following steps:
1) Close any other Adobe application running on your computer.
2) Uninstall any previous version of RoboHelp Server installed on your computer.

You cannot install RoboHelp Server 10 and RoboHelp Server 11 together on the same system. There-
fore, uninstall RoboHelp Server 10 before installing RoboHelp Server 11. However, if you want to mi-
grate data from RoboHelp Server 10 to RoboHelp Server 11, ensure that you back up the following files 
available in the [RHS-installation-directory]\web-inf folder before uninstalling Robo-
Help Server 10:
– robohelp_general_prop.properties

– robohelp_rh_areas.xml

– robohelp_server.properties

– robohelp_settings.properties

3) Install JRE 8. For more information, see Java SE documentation.

DBMS 64-bit installation instructions

Oracle 19c Oracle documentation

Oracle 12c Oracle documentation

Oracle 11g R2 Oracle documentation

Apache Derby 10.14.2 Apache Derby documentation (built-in for RoboHelp Server 
11)

http://www.oracle.com/technetwork/java/javase/downloads/java-archive-downloads-javase7-521261.html#jdk-7u51-oth-JPR
http://www.oracle.com/technetwork/database/enterprise-edition/downloads/database12c-win64-download-2297732.html
https://db.apache.org/derby/releases/release-10.7.1.1.html
https://www.oracle.com/database/technologies/oracle19c-windows-downloads.html
http://www.oracle.com/technetwork/database/enterprise-edition/downloads/112010-win64soft-094461.html
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4) Install Tomcat 8 as a Windows service. Download the 64-bit Windows Service Installer from the 
ApacheTomcat page. Run the installer and follow the on-screen instructions to complete the installa-
tion.

5) To verify that the Tomcat server is running, open the Tomcat home page in a browser window. To do 
so, enter http://<server-name>:<port-number> in the address bar of the browser window.

NOTE: 
By default, Tomcat installs on port 8080. On your local machine the server name will be localhost. 

If you see the Tomcat home page, it confirms successful installation of Tomcat. To resolve any instal-
lation and configuration issues, visit Apache Tomcat website. Consider the following points to config-
ure Tomcat:
– If necessary, in <tomcat-install-folder>\conf\server.xml, change the port number 

to a desired port number.
– Change the minimum heap space allotted to the Java Virtual Machine (JVM):

a) Run the .exe file given at <tomcat-install-folder>\bin\tomcat8w.exe
b) On the Java tab in the Apache Tomcat Properties dialog, specify 256 as the value for the Initial 

Memory Pool and Maximum Memory Pool.
c) Re-start Tomcat service.

6) (Optional) Install a supported database system. Apache Derby is the default database that is in-built in 
the RoboHelp Server 11 package. To work with other supported databases, see Supported database 
management systems.

7) Install RoboHelp Server 11. You can download the installers from Adobe RoboHelp Server 10 page. 
During installation, you can either enter the license number to install the licensed version of the 
product, or install the trial version for 30 days.

8) Once the installation is complete, start the RoboHelp Server Configuration Manager (Start > All 
programs > Adobe RoboHelp Server 11 > Configuration manager). If prompted, select the 
server.xml file for the Tomcat servlet container installed on your system.

Run Tomcat as a Window service

When you install Tomcat on a Windows Server, you have the option to run it as a Windows service and 
the service must be configured to run as a Windows user (Tomcat supports both local and network users).
1) Open Windows Service.
2) If Tomcat is running, right-click Apache Tomcat and choose Stop.
3) Right-click Apache Tomcat and choose Properties.

The Apache Tomcat Properties window appears.
4) Select the Log On tab and provide Windows user credentials.

http://archive.apache.org/dist/tomcat/tomcat-8/
http://www.adobe.com/products/robohelpserver.html


GETTING STARTED
INSTALLATION

 10

5) Click OK.

Additional configuration notes:
• For RoboHelp Server 11 authentication and licensing, Windows service must run as Windows user 

account. This Windows user must license RoboHelp Server in Configuration Manager and should have 
the read/write/execute permissions on the Tomcat installation directory, RoboHelp installation direc-
tory, and to the project storage location (if using custom projects storage location).

• Existing users of RoboHelp Server 11 can use a new/existing Windows user account and license Robo-
Help Server in Configuration Manager for the same user. During installation, update user credentials in 
the Log On tab, provide permissions to RoboHelp Server installation directory, and Tomcat directory 
for the user.

• To setup Tomcat to run as a Windows user, read 
https://tomcat.apache.org/tomcat-8.5-doc/windows-service-howto.html

Configure RoboHelp Server

1) Start Tomcat service by performing any one of the following steps:
– At the Run prompt, enter services.msc. From the Windows services dialog box, start the 

Tomcat service.
– Double-click the Apache Tomcat icon from the status bar and click Start in the Apache Tomcat 

Properties dialog box.
– Open the <tomcat-install-folder>\bin folder and double-click tomcat8w.exe to start 

Tomcat.

2) Start the RoboHelp Server Configuration Manager start (Start > All Programs > Adobe RoboHelp 
Server 11 > Configuration Manager). If prompted, select the server.xml file for the Tomcat servlet 
container installed on your system.
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3) Click File > New Context to create a new context in Configuration Manager. Once the context is 
created, you see a success message, “New context has been successfully created”. For more information, 
see Create contexts or multiple websites.

4) Configure the database or select the option to use the built-in database. See Configure a database for 
more information.

5) Configure LDAP settings if you want to use LDAP authentication. See Specify LDAP settings for more 
information.
– Verify that RoboHelp Server is running by accessing the RoboHelp Server Web Administrator link 

in the browser window. Log in to the server at:
http://<server-name>:<port-number>/<context-name>/admin/index.html 
by using the default user ID (admin) and password (admin) or by using Single Sign-On (SSO).

6) Using the configured server details, publish projects to RoboHelp Server from RoboHelp.

NOTE: 
Using the Configuration Manager is the recommended way of changing the default user ID and pass-
word. However, you can also change the default credentials by editing the robohelp_-
server.properties file in the <server-install-folder>\WEB-INF folder. To do so, 
change the DefAdminUid and DefAdminPwd properties in this file and restart Tomcat. 

NOTE: 
As an administrator, you can create users and assign them various rights (Publishing, Report viewing, 
and Admin rights) for the server. 

7) To view projects, open the browser and type the project URL in the address bar. For Example, 
http://<server-name>:<port-number>/<context-name>/server?prj=<project-
name>&type=<type-of-project>

NOTE: 
For Responsive HTML5 projects, the <type-of-project> is responsivehelp and frameless 
for Frameless projects. 

Accessing RoboHelp Server Web Administrator

To access RoboHelp Server Web Administrator, perform the following steps:
• In the Web browser, type http://<server-name>: <port-number>/<context-name>. A 

message showing “RoboHelp Server has been successfully created” is displayed.
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• Now type http://<server-name>: 
<port-number>/<context-name>/admin/index.htmlto access the login page for the Web 
Administrator. Enter the default user name (admin) and password (admin) to sign in.

• The RoboHelp Server Web Administrator page is displayed. To view your published projects, go to Proj-
ects tab.

(Optional) Configure Tomcat with an external Web server

Configuring Tomcat with an external Web server is optional. However, using an external Web server offers 
ease and flexibility while configuring settings, such as proxy and filtering rules

Install and configure Apache HTTP Server and Tomcat

Install Apache HTTP Server

1) Download the Windows binary distribution (.msi file) from 
http://archive.apache.org/dist/httpd/binaries/win32/.

2) Run the MSI file that you downloaded.
3) By default, the Apache HTTP Server is installed on port 80. If some other server is using port 80, you 

must change the port on which Apache listens for requests in the <apache-httpd- 
install>\conf\httpd.conf file. Search for the directive Listen in the configuration file and 
change the port number by changing this directive to <new-port-num>.

4) Ensure that the Apache HTTP server is working correctly. To do so, enter the URL for the Apache server 
(http://<hostname>:<port-number>) in a Web browser. The server should display a page in 
the browser that says, “It Works!”.

Download sample workers.properties

Download sample workers.properties from this page, place it in the <apache-httpd 
-install>\conf folder. Now, modify the following variables:
• workers.tomcat_home: Set to the Tomcat installation directory.
• workers.java_home: Set to the JDK path.

Download the mod_jk module
1) Download the mod_jk module for Apache from 

https://archive.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/w
in32/jk-1.2.23/. This module exists as mod_jk-apache-2.2.4.so.

2) Place the module in the <apache-httpd-install>\modules\ folder.

Modify the <apache httpd install>\conf\httpd.conf file

1) Add the mod_jk module by appending the following line of text to the <apache-httpd 
-install>\conf\httpd.conf file: LoadModule jk_module 
modules/mod_jk-apache-2.2.4.so

2) Using the JkMount command, add the context names that you want to direct to Tomcat: JkMount 
/robohelp/* ajp13 JkMount /th robohelp ajp13

https://tomcat.apache.org/connectors-doc-archive/jk2/jk/workershowto.html
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Enable Apache auto-configure

1) In the server.xml for Tomcat (<tomcat-install-folder>\conf\server.xml), enable 
Apache auto-configure. Tomcat automatically generates the files required for using mod_jk with an 
Apache HTTPS Web server.

<Engine>  
......  
<Host>  
................  
</Host>  
<Listener className="org.apache.jk.config.ApacheConfig"  
 modJk=<apache-install-folder>\modules\<mod_jk_module>  
 workersConfig=<apache install folder>\conf\workers.properties />  
</Engine>

modJK and workersConfig must have appropriate values. For example:

<Listener className="org.apache.jk.config.ApacheConfig"  
          modJk="C:\Program Files\Apache Software 
Foundation\Apache2.2\modules\mod_jk-apache-2.2.4.so"  
          workersConfig="C:\Program Files\Apache Software 
Foundation\Apache2.2\conf\workers.properties" />

2) Stop the Apache HTTP Web server if it is running.
3) Restart Tomcat. The <tomcat-install-folder>\conf\auto\mod_jk.conf file is gener-

ated. This file decides which URLs Apache passes to Tomcat.

NOTE: 
In mod_jk.conf, Tomcat creates a <VirtualHost> XML tag whose argument is the name of the 
<Host> tag just before the <Listener>(for modJK) tag in server.xml of Tomcat. Change the 
value of the name attribute of the <Host> tag to the server name. 

Include the auto-generated file in Apache’s httpd.conf file

Add “Include <tomcat-install-folder>\conf\auto\mod_jk.conf” at the start of the 
httpd.conf file.

Restart the Apache HTTP server

If the Apache HTTP server service does not start due to some error, do the following:
1) Run the command prompt.
2) Go to <apache-install-folder>\bin.
3) Run httpd.exe to check for errors.



GETTING STARTED
INSTALLATION

 14

Enable UTF-8 encoded URLs

Modify <tomcat-install-folder>\conf\server.xmland enable UTF-8 encoded URLs in all 
connector tags:

..............  
 <Connector port="9090" protocol="HTTP/1.1" connectionTimeout="20000" 
redirectPort="8443" URIEncoding="UTF-8" />  
............  
<Connector port="8009" protocol="AJP/1.3" redirectPort="8443" 
URIEncoding="UTF-8" />  
............

Set up Tomcat for HTTPS

1) At the command prompt, change to the [JAVA_HOME]\bin directory.

NOTE: 
The JAVA_HOME environment variable usually points to the Java installation directory. 

2) Run the following command: keytool -genkeypair -alias tomcat -keyalg RSA 
-keystore key1 -validity 30

A new keystore file is created in the home directory of the user who runs the command. To specify a 
different location or file name, modify the command to add the -keystore parameter followed by 
the complete path of the keystore file. You will also need to specify this new path in the server.xml 
configuration file, as described in Step 6.

3) Enter the keystore password.
4) Enter the appropriate values when prompted for your personal and organization information.
5) When prompted, enter the Tomcat key password.
6) Modify the server.xml file for your Tomcat server and add the following text, replacing the bold text 

with appropriate values for your system:

<Connector port=[port number] protocol="HTTP/1.1" SSLEnabled="true"  
maxThreads="150" scheme="https" secure="true"  
clientAuth="false"  
strategy="ms"  
address="${jboss.bind.address}"  
keystoreFile="${jboss.server.home.dir}/conf/THE_KEYSTORE_NAME"  
keystorePass="PASSWORD_FOR_THE_KEYSTORE"  
truststoreFile="${jboss.server.home.dir}/conf/THE_KEYSTORE_NAME"                
truststorePass="PASSWORD_FOR_THE_KEYSTORE"                
sslProtocol="TLS"/>
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7) Restart Tomcat.

Configure Apache for IPv6

1) To enable Apache to work with IPv6 addresses, download IPv6-enabled Apache from 
https://httpd.apache.org/download.cgi, unzip it, and follow the instructions in README.v6.txt.

2) Open <apache-httpd-install>\conf\httpd.conf, and locate the Listen directive. Add 
the directive to make Apache listen on all inbound IP v6 and v4 addresses on any identified port. 
Listen 80

3) Modify the VirtualHost tag in <tomcat-install-folder>\conf\auto\mod_jk.conf to 
enable it to accept all IP v6 and v4 requests by specifying the following:

<VirtualHost *:port no>  
....  
....  
</VirtualHost>

Install and configure Microsoft IIS with Tomcat

1) Install url-rewrite from https://www.iis.net/downloads/microsoft/url-rewrite.
2) On IIS management “Enable proxy” from “Server proxy settings.”
3) Place web.config in inetpub folder.

<?xml version="1.0" encoding="UTF-8"?> 
<configuration> 
    <system.webServer> 
        <rewrite> 
            <rules> 
                <rule name="ReverseProxyInboundRule1" 
stopProcessing="true"> 
                    <match url="(.*)" /> 
                    <conditions logicalGrouping="MatchAll" 
trackAllCaptures="false" /> 
                    <serverVariables> 
                        <set name="HTTP_ACCEPT_ENCODING" value="eee" /> 
                    </serverVariables> 
                    <action type="Rewrite" url="http://localhost:8080" /> 
                </rule> 
            </rules> 
            <outboundRules> 
                <rule name="ReverseProxyOutboundRule2" 
preCondition="ResponseIsHtml1"> 
                    <match filterByTags="A, Area, Base, Form, Frame, 
Head, IFrame, Img, Input, Link, Script" pattern="(.*)" /> 
                    <action type="Rewrite" 
value="http://localhost:8080/{R:1}" /> 
                </rule> 

https://www.iis.net/downloads/microsoft/url-rewrite
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                <rule name="RewriteRelativePaths" 
preCondition="ResponseIsHtml1"> 
                    <match filterByTags="A, Area, Base, Form, Frame, 
Head, IFrame, Img, Input, Link, Script" pattern="^/(.*)" 
negate="false" /> 
                    <action type="Rewrite" 
value="http://localhost:8080/{R:1}" /> 
                </rule> 
                <preConditions> 
                    <preCondition name="ResponseIsHtml1"> 
                        <add input="{RESPONSE_CONTENT_TYPE}" 
pattern="^text/html" /> 
                    </preCondition> 
                </preConditions> 
            </outboundRules> 
        </rewrite> 
    </system.webServer> 
</configuration>

NOTE: 
Replace localhost with system's IP address or name. 

4) Add HTTP_ACCEPT_ENCODING as a server variable in IIS management console.

Configuration Manager

The RoboHelp Server Configuration Manager enables you to perform the following actions:
• Manage contexts or multiple websites
• Configure a built-in or external database
• Set up an admin account for RoboHelp Server
• Configure LDAP settings
• Configure single sign-on using Okta
• Configure single sign-on using Active Directory Federation Service (ADFS)
• Configure search indexing settings
• Import Settings
• Migrate data from RoboHelp Server 10 to RoboHelp Server 11
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You can create or open existing contexts using the Configuration Manager. The below dialog box appears 
when trying to access the Configuration Manager. Users with admin rights will be able to access the Config-
uration manager by clicking Yes when prompted.

The default User ID and password required to connect to the server and the database are admin and 
admin. You do not need a password to connect to the Derby database, as it is the default database.

Create contexts or multiple websites

You can host different Help systems by creating multiple contexts in Tomcat. Contexts refer to websites, 
where a project can be published. You can configure different instances of RoboHelp Server (on a single 
installation) to run on each of these contexts. These contexts run on the same IP address and port number 
but with different context names.

By default, RoboHelp Server creates a single context called robohelp. You can create another context using 
the Configuration Manager.

Create a context using Configuration Manager

You can create contexts to publish projects from RoboHelp.
1) Select Start > All Programs > Adobe RoboHelp Server 11 > Configuration Manager.
2) Select File > New Context.
3) Do one of the following:

– If you want to deploy the new context in the root context, select Deploy in root context option and 
enter a Directory Name.

NOTE: 
The root context is a special, empty context path. If an application is deployed in the root context, 
it listens for requests on the http://<host-name>:<port-number> URL, instead of a 
sub-URL. 
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– Specify a new Context Name and Directory Name. For example, you can have robohelp2 as the 
new context name and rh2 as the directory name.

NOTE: 
To open an existing context, select File > Open Context. 

4) Click OK.

NOTE: 
After creating a context, Configuration Manager re-starts the Tomcat service. 

Update uriworkermap.properties for IIS. If you have configured Tomcat to run with IIS, update 
uriworkermap.properties to map the new context path to the ajp connector.

/robohelp/*=ajp13  
/robohelp=ajp13  
/robohelp2/*=ajp13  
/robohelp2=ajp13

 NOTE: 
With Tomcat configured with Apache, if you configure Tomcat to auto-generate the mapping file, 
mapping for new context is automatically added to <tomcat-path>\conf\auto\mod_jk.conf. 

Related links:
▶ Web Administrator tasks

Delete a context

• Click File > Open Context.
• In the Open Context Settings dialog, select the context that you want to delete and click OK.
• In the main Configuration Manager window, click Delete. When prompted for confirmation, click Yes.

NOTE: 
When you delete a context, all project data associated with the context is deleted. However, the data-
base associated with the context is deleted only if it is a Derby database. For Microsoft SQL 
Server/SQL Server Express Edition and Oracle, you need to manually delete the database. 
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Configure a database

You can select the Derby database (built-in) or an external Oracle or Microsoft SQL Server/SQL Server 
Express Edition database to store user feedback and troubleshoot any Help content issues.

Select a database and connect to it

You can use the Configuration Manager to select and configure a database.
1) In the Configuration Manager window, select one of the following options:

– Built-in Database
– Oracle 19c/Oracle 12c or 11g R2/Microsoft SQL Server/Microsoft SQL Server Express Edition

If you selected Oracle 12c or 11g R2/Microsoft SQL Server/SQL Server Express Edition, follow these steps:
1) Enter the Database URL.
2) Enter the Database Username and Database Password.
3) Enter the JDBC Driver Class and click the Browse button to choose the JDBC Driver Path.
4) Specify the Connection Pool Size. The Connection Pool Size determines the maximum number of 

concurrent connections to the database.
5) Click Test Connection to check if the connection has been setup.

Time zone configuration

As a standard, using Coordinated Universal Time (UTC) makes it convenient to share data across all time 
zones. Starting with Update 3, RoboHelp Server can store information in the database in UTC time zone 
while still seeing timestamps in the UI displayed in the user’s local time zone.

The optional configuration works at the context level and can be enabled by RHS admin users by setting 
up a parameter in the context specific properties file.

NOTE 
Time zone configuration is currently supported for Oracle and MS-SQL databases only. 

To configure UTC time zone

 IMPORTANT 
When performing the below UTC configuration for data-specific commands, contact support by raising 
a ticket in the Admin console 

1) Ensure to take a backup of the existing database tables specified in the alter document.
2) Run the database-specific commands in accordance with the corresponding context.

adminconsole.adobe.com
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3) Add the TimezoneforRHS=UTC parameter to the <context-name>_server.properties file 
in the WEB-INF folder of the installation directory. TimezoneforRHS=UTC Allows to store data in 
UTC time zone.

4) Restart the RoboHelp server.

Set up an admin account for RoboHelp Server

1) Do one of the following:
– If you do not want to use database authentication for RoboHelp Server, leave the Use LDAP 

Authentication option unselected. Now, specify the user name and password for a new admin 
account in the Default Admin Account for Web Administrator section.

– If you want to use LDAP authentication for RoboHelp Server, follow these steps:
i) Select Use LDAP Authentication.
ii) Specify the necessary LDAP settings. See Specify LDAP settings.
iii) Specify an LDAP user name in the Default Admin Account for Web Administrator section. This 

user will be prompted for the LDAP password when it attempts to log in to Web Administrator.

NOTE: 
For LDAP, you are required to enter the fully-qualified distinguished name. 

2) Close the Configuration Manager window. RoboHelp Server automatically restarts the Tomcat service.
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Specify LDAP settings

If you want to use LDAP authentication for RoboHelp Server, specify the settings in the LDAP section of the 
Configuration Manager. For clear understanding of these settings, consider the following LDAP directory 
structure example:

LDAP Server URL
The URL of your organization's LDAP server. This URL includes the scheme, host name, and port 
number; For example, ldap://myladpurl:389.

Base Node For User Search
The LDAP base node within which you want to find users. For example, If you want to search for regular 
employees within the sales department, then specify the value for this parameter as: ou=regular, 
ou=sales, dc=example, dc=com.

Base Node For Group Search
The LDAP base node within which you want to find groups. For example, if you want to search for 
groups within the personal department, then specify the value for this parameter as: ou=personal, 
dc=example, dc=com.

User ID Attribute Name
The LDAP node attribute that determines the user ID. In the given LDAP directory structure example, 
this attribute is defined as cn. The value of this attribute depends on the implementation of your LDAP 
directory structure.
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Group ID Attribute Name
The LDAP node attribute that determines the group name. In the given LDAP directory structure 
example, this attribute is defined as ou.

Group Member Attribute
The attribute of the LDAP group node that determines the members of the group. For example, if you 
want to set this to regular employee group in the sales department, then specify the value as: member.

Configure Single Sign-On (SSO)

RoboHelp Server supports two ways of configuring Single-On using OKTA or ADFS configuration:

Single Sign-on using OKTA

To use Single Sign-On (SSO) authentication via OKTA for RoboHelp Server, configure the OKTA settings in 
the SSO section of the Configuration Manager. The description of the required fields are as follows:
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OKTA Base URL
The domain of your organization's OKTA server authentication; For example, 
https://{yourOktaDomain}.

In the URL, replace {yourOktaDomain} with your organization’s base URL.

OKTA allows you to create multiple Custom Authorization Servers within a single Okta org that you 
can use to protect your own resource servers. Within each authorization server, you can define your 
own custom OAuth 2.0 scopes, claims, and access policies to support authorization for your APIs.

OKTA Issuer
The URL to an Okta Authorization Server; for example, the default authorization server address is 
https://{yourOktaDomain}/oauth2/default.
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Redirect URI Pathname
The redirect URI pathname specifies the location where OKTA returns a browser after the user finishes 
authenticating with their Identity Provider. The redirect URL is fixed, based on the context name, which 
is always "<context-name>/admin/index.html".
Note that this redirect URL, 
https://<server-name>:<port-number>/<contextname>/admin/index.html needs 
to be added in the redirect paths of the OKTA application being used for authentication.

Response Type
The Response Type determines which flow is used. The token (required) and id_token (optional) 
are currently supported for verification of authentication. For example, if you wish to use token and 
id_token, then this field should be specified as token, id_token.

ClientID
The ClientID of the OKTA application is used for authentication.

Scope
The scope of the OKTA parameters, determine the claims that are returned in the id_token. This 
includes the scopes that you want to request authorization for and separate each by a space. You can 
request any of the standard scopes, such as email, profile and openid.

Single Sign-On using ADFS

Pre-requisites for enabling ADFS integration with RoboHelp Server:
• OpenID with OAuth 2.0 are the currently supported protocols.
• Both the AuthCode Grant Flow and the Implicit Grant Flow of OAuth 2.0 are supported.
• To use Implicit Grant Flow, ensure to enable the ImplicitGrantFlow setting in AD server settings, 

if not enabled.
• To use AuthCode Grant Flow, specify isImplicitGrantFlowEnabled=0 in the 

<context-name>_server.propertiesfile in the WEB-INF folder of the installation directory.
– The Boolean value 0 is specified when user wants to use ADFS configuration, but does not want to 

enable ImplicitGrantFlow.
• While setting up Configuration Manager, ensure that you provide a unique standard attribute for 

“Token Primary Key”. It is one of the claims which uniquely identifies a user. For example, 
“preferred_username”

• Ensure that the “Token Role Key” attribute is present in the decoded JSON Web Token (JWT). It is a 
mandatory field to enable the authorization workflow. For example, if the value for the “Token Role 
Key” field is ‘roles’, make sure the attribute ‘roles’ is present in the JWT token.
Refer to this sample Microsoft Azure token below:

{ 
   "aud": "560f3fff-f027-48dc-92b3-fdcd97826f8e", 
   "iss": 
"https://login.microsoftonline.com/fa7b1b5a-7b34-4387-94ae-d2c178dec

https://oauth.net/2/
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ee1/v2.0", 
   "iat": 1633064904, 
   "nbf": 1633064904, 
   "exp": 1633068804, 
   "aio": 
"AVQAq/8TAAAAw0xt/W8LVReXe1zqrS0U4DdY43hMkZ1+P3dLPO647Kl6kCAW7fWaqP2
uI2rRljfEqivGwzDteXjY3kTWumTM6ZClrbV41LGY4wUH3HzCysQ=", 
   "azp": "560f3fff-f027-48dc-92b3-fdcd97826f8e", 
   "azpacr": "1", 
   "name": "admin", 
   "oid": "39e2dbde-338b-41f3-af3f-aef31e4dcada", 
   "preferred_username": "admin@companyname.com", 
   "rh": "0.ASYAWht7-jR7h0OUrtLBeN7O4f8_D1Yn8NxIkrP9zZeCb44mANk.", 
   "roles": [ 
   "ssorole4", 
   "ssorole1" 
   ], 
   "scp": "access_as_user", 
   "sub": "dCBBb1RY4-dq4bulYk3bUeshgvIxF6BsH-VsxEL24M4", 
   "tid": "fa7b1b5a-7b34-4387-94ae-d2c178decee1", 
   "uti": "EeBlLBj_ykCM8NdQiAe5AA", 
   "ver": "2.0" 
}

NOTE: 
The default value for the “Token Role Key” is ‘roles’. Leaving this field blank in the Configuration 
Manager will take the default value as ‘roles’. 
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Configure Single Sign-On using ADFS

To use Single Sign-On (SSO) with any other authentication server, configure the Active Directory Federa-
tion Service (ADFS) settings in SSO section of the Configuration Manager. The description of the required 
fields are as follows:

Authorize Endpoint
This is the authorization API endpoint of your SSO authorization server. For example, 
https://login.microsoftonline.com/common/oauth2/v2.0/authorize.

Token Endpoint
This is the token API endpoint of your SSO authorization server. For example, 
https://login.microsoftonline.com/common/oauth2/v2.0/token.

Redirect URI Pathname
The Redirect URI Pathname specifies the redirect URL of the browser, after the user finishes authenti-
cating with their Identity Provider. The redirect URIs are fixed, based on the context name, which is 
always "/<context-name>/server" and "</context-name>/admin/index.html".

https://login.microsoftonline.com/common/oauth2/v2.0/authorize
https://login.microsoftonline.com/common/oauth2/v2.0/authorize
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Note that this redirect URL, 
"https://<server-name>:<port-number>/<contextname>/server" and 
"https://<server-name>:<port-number>/<contextname>/admin/index.html" 
needs to be added in the redirect URIs of the authorization server.

Response Type
The Response Type determines which flow is used. The authorization code flow and token flow are 
currently supported for verification of authentication. This field should be specified as token, code.

Client ID
The Client ID of the application that is created for RHS authorization on the authorization server.

Client Secret
The Client Secret of the application that is created for RHS authorization on the authorization server 
(this is not required for all applications).

Scope
The scope determines the extent of authorization that is returned in the id_token. Include the scopes 
that you want to request authorization for and separate each one of them by a space.You can request 
any of the standard scopes, such as email, profile and openid.

Token Primary key
The Primary Key in the granted token, uniquely identifies a user. This is received from the token 
endpoint and user info of the granted token.

Token Role Key
This attribute specifies the claim which consists of the list of roles assigned to a user for the granted 
JWT token. To enable authorization, ensure that the value entered in this field matches the claim 
containing the list of roles in the JWT token.

NOTE 
Although the ‘roles’ in ADF S are comparable to the ‘groups’ in LDAP (Lighweight Directory Access 
Protocol), there is a significant difference in the workflow. LDAP allows for the verification of any 
AD/LDAP group; however, this is not possible in ADFS. Hence, an administrator needs to ensure that 
the existing or newly added roles are first present in ADFS, and later added with the same name in 
RoboHelp Server. 

Extra Parameters
This field adds any additional parameters to be sent to the server for authorization. The parameters 
should be URL encoded. For example: &param1=value1,&param2=value2.
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Specify search settings

You can select the following search options in Configuration Manager:

Reindex Documents At Server
Lucene reindexes the published projects on RoboHelp Server. The index published with RoboHelp 
project is ignored.

Substring Search Is Enabled For Client Index
Enables substring search for client-side indexing on RoboHelp Server. Substring search is enabled only 
for client-side indexing, since it is not supported for server-side indexing. For more information about 
substring search, see RoboHelp search basics in Using RoboHelp (2019 release)

Persistent Storage

Allows to customize the storage path as per requirements for projects of RoboHelp Server contexts. 
These projects are stored within the RoboHelp installation category by default. Select Use custom 
project storage path and enter the path within the text box in Configuration Manager.

NOTE: To use custom project storage option, add 
<url-pattern>/robo_files/*</url-pattern> to <servlet-mapping> configuration in 
<RHS Installation Directory>\WEB-INF\web.xml. Servlet mapping configuration looks 
like:

<servlet-mapping> 
          <servlet-name>RoboHelpServer</servlet-name> 
            <url-pattern>/server</url-pattern> 
            <url-pattern>/rest/*</url-pattern> 
            <url-pattern>/reports</url-pattern> 
            <url-pattern>/collaboration</url-pattern>          
</servlet-mapping>

 Restart is required post making changes in web.xml 

https://help.adobe.com/en_US/robohelp/2019/robohtml/robohelp_classic_2019_help.pdf
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Migrate context data

You can migrate context data from RoboHelp Server 10 to RoboHelp Server 11 for one or more contexts. 
The following data is migrated:
• Published RoboHelp projects
• Information about areas
• Information about users and groups
• User/group permissions on areas
• Usage data and statistics for reports

NOTE: 
Usage data for RoboHelp projects is migrated only if you choose to migrate the corresponding proj-
ects. 

IMPORTANT 
While migrating RoboHelp Server 10 analytics data, operating system and browser data is not 
migrated to RoboHelp Server 11. 

Note that Oracle and Microsoft SQL Server databases are not replicated during migration. Instead, the 
schema for these databases is updated, such that it becomes compatible with RoboHelp Server 11. Once 
the database schema has been updated, the database can no longer be used with the previous RoboHelp 
Server versions.

During migration, you can choose the contexts whose data you want to migrate to RoboHelp Server 11. For 
example, you can choose to migrate data for production contexts while not migrating the data for tran-
sient/test contexts.

You can migrate data for only RoboHelp Server 10 contexts to RoboHelp Server 11. Migration from earlier 
RoboHelp Server versions is not supported. Note that if you are migrating data from MS Access, then you 
must have it installed on the machine where RoboHelp Server 11 is deployed. You can download MS 
Access Runtime from here .

NOTE 
As part of migration planning, evaluate if you want to migrate RoboHelp projects to RoboHelp Server 
11 or upgrade them from previous RoboHelp versions to the latest release of RoboHelp. Upgrading the 
projects lets you benefit from the new authoring features in the latest release of RoboHelp. 

https://www.microsoft.com/en-in/download/details.aspx?id=10910
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Migrate data from RoboHelp Server 10 to RoboHelp Server 11

NOTE 
Do not install RoboHelp Server 10 and RoboHelp Server 11 on the same machine. Uninstall RoboHelp 
Server 10 from the machine before installing RoboHelp Server 11. However, if you want to migrate 
context data from RoboHelp Server 10, ensure that you do not manually remove data from the Robo-
Help Server directory after uninstallation. 

1) In Configuration Manager, select File > Migrate Legacy Data.
2) Browse and select the RoboHelp Server 10 installation path. Specify a network path if RoboHelp Server 

10 is installed on a machine different from the machine on which you’re installing RoboHelp Server 11.
3) In the Contexts area, select one or more contexts to migrate.

NOTE: 
The existing contexts in RoboHelp Server 11 are displayed in the existing RoboHelp Server 11 Contexts 
box. If you choose to migrate a context with the same name as an existing context, all data in the 
existing RoboHelp Server 11 context is overwritten. 

4) Specify the following Database details

Database URL
The URL of the database to which the content is to be migrated.

Database Username
The Username required to log into the database.

Database Password
The Password required to log into the database.

JDBC Driver Class
JDBC Driver class (in case of external database).

JDBC Driver Path
JDBC Driver Path (in case of external database).

5) Specify the following Migration Settings:

Migrate All Projects
Migrate all RoboHelp projects published to the selected contexts.
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Migrate Usage Data
Migrate project usage data and statistics along with the projects.

Migrate All Users/Groups And Their Permissions
Migrate information about users/groups and their permissions from RoboHelp Server 10 to RoboHelp 
Server 11.

6) Specify the Server URL in the given format 
http://<server-name>:<port-number>/<context-name>/server.

7) Click Start Migration.

NOTE: 
If the migration of one or more contexts fails, RoboHelp Server continues migrating the other 
contexts that you selected in Step 3. 

8) Review the Migration Log. When migration is complete, click OK.
9) If RoboHelp Server 10 is installed on a machine different from the machine on which you are installing 

RoboHelp Server 11, recreate the settings for Oracle or Microsoft SQL Server database management 
systems.

10) Close the Configuration Manager window. RoboHelp Server automatically restarts the Tomcat service.

Import Settings

Select Import Settings to import the settings from an existing context on to your Robohelp Server installa-
tion instance. These settings are imported from a Setup zip file.

NOTE: 
For more details about the Setup zip file, see Exporting Setup for RoboHelp Server. 

NOTE: 
As an admin, you need to have the Setup zip file on the system having RoboHelp server installation to 
which the setup has to be imported. The Setup zip file must not be renamed during copy. 

To import, follow the steps given below:
1) In Configuration Manager, select File > Import Settings.
2) Browse and select the setup zip file in the Source section.
3) In the Destination section, select the context to which you want to import the settings.
4) All the project and area settings of the existing context is replaced by the data from the Setup zip file.
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5) Enter the Server URL in the format 
http://<server-name>:<port-number>/<context-name>/server.

6) Click Import. Once the import is completed, click OK.
RoboHelp Server automatically restarts the Tomcat service.

Set up and publish projects on RoboHelp Server 11

Follow the procedure given below to setup RoboHelp Server and publish projects from RoboHelp.

Setup RoboHelp Server in the latest release of RoboHelp and 2019 release

You must create and configure a profile before publishing your output to RoboHelp Server. To create and 
configure a profile:
1) Choose Edit > Publish Profiles. The Publish Settings dialog box opens.
2) Click + to create a new profile.
3) In the Server Type field, select the type of server as RoboHelp server. Default is SharePoint Online. 

Other fields in the dialog box can be changed based on the server type selected.
4) For the SharePoint Online server type, do the following:

– Name: Shows the default profile name. Modify the name if required.
– Connection Profile: Displays the connection profiles created using the Connection Profiles dialog 

box (accessed by choosing Collaborate > Connection Profiles). Choose a connection profile from 
the drop-down list. If no connection profile is listed, create one using the Connection Profiles dialog 
box.

– Remote Path: Specify the server path at which you want to publish content. The default value / 
publishes to the default directory on the server.

5) For the RoboHelp Server server type, do the following:
– Name: Shows the default profile name. Modify the name if required.
– Address: Specify the address of the Robohelp server to which you want to publish your projects. 

The address must be in the following format: 
http://<server-name>:<port-number>/<context-name>/server

– server-name: The host name or IP address of the machine on which RoboHelp Server is setup. If its 
on the same machine, you can specify localhost as server name.

– port-number: (Optional) The port on which RoboHelp Server is running. Default is 8080. If you are 
using port 8080, specify it here. However, if you are using the default ports for HTTP or HTTPS 
protocols, you need not provide the port number. For example, the default port for HTTP is 80. So 
if you are using HTTP and port 80, you need not provide the port number.

– context-name: The context to which you want to publish. Default is robohelp. For example, 
http://localhost:8080/robohelp/server.

– User ID and Password: Enter your credentials.
For ADFS/OKTA configured contexts, select Use Single sign-on (SSO) > Login.
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– Areas: Select an area on the server on which you want to publish content.

6) Click Save. RoboHelp saves the profile and displays the profile name under the Profiles column. To edit 
a profile, click the profile name and edit its fields. To delete a profile, click against it.

Publish projects from RoboHelp

The following procedure helps you publish projects from the latest release of RoboHelp, 2019 release.

Publish projects from the latest release of RoboHelp and 2019 release

You can configure a Responsive HTML5 and Frameless output presets to link it to the RoboHelp Server 
profile, and then publish your content to one or multiple RoboHelp Servers.
1) Click the Output tab in the standard toolbar. Output Presets is the default selection in the Output 

toolbar.
2) In the Output Presets panel, double-click an output preset to edit it.
3) In the output preset editor, click the Publish tab to view the servers created across projects. You can 

also edit server information in the Publish Profiles dialog box, which you can launch by clicking .
4) Select the profiles (servers) to which you want to publish content.
5) Select Republish All to republish the entire content. If this field is not selected, RoboHelp publishes the 

updated content only since the previous publish and not the entire content.
6) To publish to the selected profiles (servers), click the output preset and then click  in the standard 

toolbar. Or right-click the output preset and click Publish. If you selected multiple RoboHelp Servers, 
RoboHelp publishes to RoboHelp Servers in a sequence. Two prompts appear, one displays publishing 
information (such as the file being published, preset name, and server name) and the other displays 
publishing status.

7) To view the published content, click  in the Results column against the published profile. If 
publishing fails, the Results column does not show the  icon.
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Administering server

Administrator and end user tasks

The Adobe RoboHelp Server software uses projects created in RoboHelp and stores information to create 
end-user reports. It generates reports based on how end users navigate and use online Help systems.

You can share these reports and analyze them to optimize the value of your content. In addition, RoboHelp 
Server reports help you identify the key areas of your Help content that need to be updated or enhanced 
on priority.

End users can view the online content using a browser.

Use the authoring tool to create content, and publish output. You can use a web browser to view the 
content on the RoboHelp server.

Server administrator tasks

• Configure the server or website.
• Host the Help site.
• Set user permissions.
• Provide the URL and Help site port number to the documentation manager.

Your tasks

• Obtain the server’s URL.
• Connect to the server from the authoring tool project.
• Publish the project from the authoring tool.
• Create protected areas on the server.
• Manage user groups.
• Assign permissions to the relevant groups.
• Test the system on the server.
• View reports and web administration.
• Work with a developer to call context-sensitive Help (if needed).
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Web Administrator tasks

About the Web Administrator

The Web Administrator is a browser-based server interface. It lets administrators or documentation 
managers maintain permissions for users without going through a network administrator. It enables you 
to maintain databases by letting you delete old data from the Web Admin interface.

Open the Web Administrator interface

1) Do one of the following in your browser: 
– If RoboHelp Server is not installed on the same computer, use the Web Administrator URL: 

http://<IP address or server-name>:<port-number>/<context-name> 
/admin/index.html

– If RoboHelp Server is installed on the same computer, use this Web Administrator URL: 
http://localhost:<port-number>/<context-name>/admin/index.html

2) Enter the user name and the password as admin and admin respectively.
3) Click Sign in.

NOTE: 
You must have the Apache Tomcat server running before starting RoboHelp Server 11. 

Enable user authentication

The Web Administrator interface enables you to segregate the Help content published on the server into 
protected and public areas. Only authenticated users can view the content published in protected areas, 
but no authentication is required to view content published in public areas.

NOTE: 
You do require authentication to publish content to public or protected areas. 

By default, RoboHelp Server creates a public area, general.

IMPORTANT 
You cannot mark the general area as protected and it cannot be deleted. 
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To make an area protected, you can select the Protected area option in the Areas page of the Web Admin 
interface. For more information on Protected areas, see Managing areas. You can define several sets of 
privilege groups and assign different rights to different users. These rights include view only, publish, admin 
rights, and viewing reports. You can manage the groups and their privileges from RoboHelp Server Web 
Admin pages. RoboHelp Server 11 provides user authentication through both database and LDAP. You can 
also use HTTP request and response mechanism to authenticate users, see Authenticate users via HTTP 
request for more information.

Authenticate LDAP users

IMPORTANT 
The recommended way of configuring LDAP settings is through the Configuration Manager. See Specify 
LDAP settings. 

You can use the <context-name>_server.properties file to authenticate an LDAP user or an 
administrator. Do the following: 
• Comment the authtype = db property, specify your LDAP user name in the DefaultAdminUid 

property, and do not specify your LDAP password in the DefAdminPwd property.
• Uncomment and specify your organization LDAP details: 

authtype = ldap  
ldapURL = ldap://ldapserver:389  
usersearchbase = ou=people,o=org  
rolesearchbase = ou=groups,o=org  
useridkey = uid  
rolename = cn  
rolesearch = uniqueMember

• Restart the Tomcat service to log in as an LDAP user.

The following table lists the properties stored in the <context-name>_server.properties file: 

Property Name Description Property Value Required (Yes/No)

DatabaseType Specifies the database used 
(supported types are oracle/sql)

oracle/sql (Apache 
derby by default)

Yes

authtype Specifies the authentication 
mechanism used.

db/ldap Yes

LDAP Server 
URL

The URL of your organization’s 
LDAP server

If authtype is ldap

usersearchbase The LDAP base node within which 
you want to find users. For 
example, dc=company, dc=com.

URL of LDAP Server 
of the organization

If authtype is ldap
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IMPORTANT 
The recommended way of editing properties is through the Configuration Manager. 

rolesearchbase The LDAP base node within which 
you want to find groups. For 
example, dc=company, dc=com.

If authtype is ldap

useridkey The LDAP node attribute that 
determines the user ID.

user ID key If authtype is ldap

rolename The LDAP node attribute that 
determines the group name.

role name key If authtype is ldap

rolesearch The attribute of the LDAP group 
node that determines the 
members of the group

role attribute name If authtype is ldap

DefAdminUID When server is started for the first 
time, server is not connected to 
the database. Therefore, access 
permissions for a given user 
cannot be verified. Provide a 
default user ID which has the 
admin rights and can access the 
web admin.

User ID which has 
admin access to 
RoboHelp Server by 
default.

Yes

DefAdminPwd User ID which has admin access to 
RoboHelp Server by default. For 
LDAP authentication, password for 
the DefAdminUid is verified from 
the LDAP server. For database 
authentication, provide the default 
password for the default user ID.

Default Admin 
password

if authtype is db

maxload Specifies maximum number of 
open concurrent database 
connections depending on the 
database used for report logging.

maximum number 
of open connections 
database can handle.

ProjectsURLBas
e

Context path of the Help projects 
on the Tomcat server.

ProjectsDirBase Top-level directory of Help 
projects
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Authenticate users via HTTP request

You can use the HTTP request and response mechanism to authenticate users in RoboHelp Server 11. This 
method is used to access protected pages on the server. The authentication session is managed by the 
server and browser, and the authentication parameters are supplied in XML format. You can also use the 
HTTP-based authentication mechanism to authenticate LDAP users.

To authenticate users via HTTP request, perform the following steps:
1) Change the help topic URL to include the authentication mechanism, as shown in the following 

example:
Original help topic URL: 
http://<server-name>:<port>/<context-name>/server?prj=<project-name>&a
rea=<protected-area>&tpc=<-topic-.htm>&type=<type-of-output>

Modified help topic URL: 
http://<server-name>:<port>/<context-name>/server?prj=<project-name>&a
rea=<protected-area>&tpc=<-topic-.htm>&mgr=auth&type=<type-of-output>

NOTE: 
In the modified help topic URL, the authentication mechanism is specified as mgr=auth. 

2) Send HTTP POST request to the modified help topic URL.
3) Provide authentication parameters in XML SOAP Envelope, as shown below: <?xml 

version="1.0" encoding="UTF-8"?><SOAP-ENV:Envelope 
xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/" 
SOAP-ENV:encoding-
Style="http://schemas.xmlsoap.org/soap/encoding/"><SOAP-ENV:Header 
/><SOAP-ENV:Body> <login> <UID name="username"></UID> <PWD name="pass-
word"></PWD> </login></SOAP-ENV:Body></SOAP-ENV:Envelope>

4) When this request reaches RoboHelp Server, the server decodes the user credentials from the XML 
Soap Envelope and authenticates the user.
If successful, RoboHelp Server sends HTTP response in JSON format as shown below and redirects user 
to the requested page: '{"redirect":"Encoded Redirect URL of the Help Topic"}’
In case of any error, it sends HTTP response in JSON format as shown below: '{error:"Error 
Message"}'

About RoboAdmin group

By default, RoboHelp Server creates an Admin group called RoboAdmin. The RoboAdmin group has the 
following permissions: 
• Creation and deletion of areas.
• Publishing and viewing projects in all the areas.
• Viewing reports for all the areas.
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• Creation and deletion of groups.
• Assigning and removing users from groups.
• Assigning and removing publishing or viewing access and report viewing to an area.

RoboHelp Server adds the default user specified in the configuration file as a member of RoboAdmin 
group. You can use the Configuration Manager to change the default user ID and then restart the server.

On restarting the server, RoboHelp Server adds the new user ID as a member of the RoboAdmin group. 
But the earlier user still exists as a member of the RoboAdmin group. If you want to remove the earlier user 
ID from the RoboAdmin group, log in with the new admin ID and remove the earlier user ID from the Users 
page.

Managing Users

When you sign in to the Web Admin interface, the Users page opens. In this page, you can create groups 
and assign users to them. You can also select existing groups and add or delete users from the group. 
Consider the following while managing groups or users: 
• A user ID or a group cannot have special characters and cannot be blank.
• As an administrator, you can remove users from a group but you cannot remove yourself from the 

Admin group.
• Depending on the type of authentication that is LDAP or database, enter a user name and a password.

NOTE: 
If you are logged in as an LDAP administrator, you get an additional option of adding a new LDAP 
user or an existing LDAP group. For example, your LDAP group can include all the people in HR or 
Finance department. 

• If you are logged in as a user, you cannot remove yourself from your group.

NOTE: 
Click Users to access the Users page from some other page. 

Managing areas

You can manage areas from the Areas page of the Web Admin interface. Click Areas to create or delete 
areas and assign permissions to areas.
• You can click the Add button next to the Areas list to create an area. Select the option to make the area 

protected or leave it deselected to make it public.
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NOTE 
RoboHelp Server creates a default area, General, that cannot be protected or deleted. 

Protected areas allow you to create areas to publish protected content with restricted access. A user 
must be authenticated and have access rights to view content published in a protected area.
Perform the following steps to ensure that a user needs authentication to access published content in 
protected areas.
a) Locate the web.xml file from the WEB-INF directory of the RHS installation folder.
b) After creating a context, add the following in the web.xml file:

<filter-mapping>:  
    <filter-name>AuthFilter</filter-name> 
    <url-pattern>/robo_sample/secure_server/*</url-pattern> 
    < url-pattern >/<context-name>/secure_server/*</url-pattern> 
</filter-mapping>

NOTE 
Ensure to add the url-pattern tag for every context containing protected areas. 

c) Restart the RoboHelp Server.
d) Make an area protected by selecting the Protected check box option under the selected area in the 

Web Administrator UI.

In the instance of a user accessing a URL of a protected area’s published content varies for contexts:
– For other contexts (Default/LDAP)

• The unauthenticated user is redirected to the RoboHelp Server Web administrator login page.
• User logs in with LDAP credentials:

- If authorized, user can paste the URL in a new tab to view content.

-If not authorized, user is redirected back to the RoboHelp Server Web Administrator login 
page.

– For SSO based contexts (ADFS/OKTA)
• The unauthenticated user is redirected to the SSO login page.
• User logs in with login credentials:

- If authorized, the content loads for the user to view.

- If not authorized, user is redirected back to the RobHelp Server Web Administrator home 
page.
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• The request to add an area goes to the server. If the area name exists or if you have not entered any 
area name, an error message appears.

• You can add a user group to an area to assign it viewing, publishing, or report viewing rights.
• Public areas do not have viewing restrictions and thus, the Viewing option for the public areas is always 

disabled.
• You can select a user group from the Add new group pop-up menu and add it to a selected area. If the 

group is already assigned to the selected area, a message appears.

NOTE: 
As an administrator, you can select the Protected option and change a public area to protected. Click 
Apply after making the necessary changes. 

Managing projects

To manage projects on a server, you can click Projects in the Web Admin interface. The list of projects 
listing name, type, and published dates of the projects and the name of the authors. This default project is 
used to resolve name conflicts among windows, context IDs, topics, and so on. Other Help projects use the 
default project settings on the server.

Areas
Displays the list of areas defined on the server.

NOTE: The areas list shows all the areas only if you have admin rights assigned to you. If you have user 
rights, you can view the areas for which you have the viewing rights. 

Project List
Determines the default project if you have several projects merged based on the project order. The first 
project listed is the default (Master).

View Project
Displays the contents of a project.

Delete
Deletes the selected project. Error messages appear in the Adobe RoboHelp error log if other users 
attempt to access a deleted project.

NOTE: This button is visible only if you have logged in as an administrator. 
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Move Up/Move Down
Reorder projects.

NOTE: This button is visible only if you have logged in as an administrator. 

Automatically Merge Project
Merges project of the same type (Responsive HTML5 or Frameless).

 NOTE 
Merging all projects from within RoboHelp Server ignores project merging information set in the Robo-
Help HTML application. 

You can access area-specific projects using the following URL: 
http://<server-name>/<context-name>/server?prj=<project-name>&area=<area-
name>&type=<type-of-output>

If you do not specify an area attribute, the default area is considered. You must have project viewing 
permissions to the area.

Scheduling databases

Select Settings on the Web Administrator interface to select options for data in the database and to select 
options for scheduling search indexing on the server.

To make database-specific changes, select Databases in the Settings list. The Database section shows the 
following options: 

Delete All Data Over
Select to delete user actions and server errors older than the number of days specified. Specify the time 
at which the process takes place.

Delete All Data Now
Select if you want to delete the data right now.

Delete All Data Over Days Now
Select to delete the data, older than the specified period right away.

Keep All Data
Select to keep all data.
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 NOTE: 
You cannot delete user information or statistics because they are reused and were not created on a 
specific date. 

When you delete database data, the size of the database is reduced when you shrink or compress it.

Scanning documents

Regular scanning of documents updates the search index on a regular basis. You can schedule scanning of 
documents at a weekly, daily, or hourly basis. With every scheduled scanning, the RoboHelp server reads 
all the published projects. The server recreates indexes only if you have set the re-index property in the 
server.properties file to true. By default, the re-index property is set to true. The search setting pane is not 
visible if the re-index property is set to false. The indexing takes place only at scheduled intervals of rescan-
ning and when a project is published on a server.

Exporting Setup for RoboHelp Server

RoboHelp Server Web Administrator lets you export the server-setup for a given context to another 
instance of RoboHelp Server 11 installation on a different machine. This is required:
• When you have created a staging setup on a machine and once it is certified, you want to move the 

setup to a production machine.
• When you want to create a duplicate RoboHelp Server setup which can be used as a backup in case 

the primary setup fails.

NOTE: 
You should have admin rights to export the setup file. 

The setup is exported as a setup zip file. It consists of:
• Areas created in the context
• Project merging option for each area
• Context wide settings like search schedule settings, database cleanup settings, and moderation settings
• Authentication mechanism (database/LDAP)
• Information about users, groups and permissions
• Published projects
• Usage data captured

To export, follow the steps given below:
1) In RoboHelp Server Web Administrator, click Settings > Export Setup
2) In the Export Setup section, select what you want to export. You can choose to export projects, usage 

data.
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3) Click Export.
4) Click Yes on the Setup Export confirmation dialog box.
5) Export is initiated.
6) Click OK once the export is completed.

The Setup zip file is exported at the location <RHS-Install- Path>\web-INF\SetupExport\as a 
<context-name>.zip file. The setup zip file contains the following folders: 
• database - This folder contains the .CSV files which contain the data exported from the database.
• web-INF - This folder contains all the settings files for the exported setup.
• projects - This will contain all the projects published to this context.

Troubleshooting

Click Troubleshooting if you are an administrator or if you have report access to some areas. The Trouble-
shooting page displays errors generated in a selected area. You can select an error and click More Info to 
view detailed information on the error generated in an area. Click Delete to delete error messages gener-
ated in an area or Delete All to delete all the error messages for the specified area.

Errors can occur due to various reasons such as absence of a default topic, missing TOC, index, or a glossary 
file, missing topic, missing context ID, or missing window. The error information helps you to review the 
Help content and fix issues.

Reports

About Reports

Use reports to understand the user needs and accordingly update your Help content. RoboHelp Server 
generates reports based on how end users enter the system, navigate, and use your Help content. You can 
share the generated report to analyze and optimize the value of your content. Reports are available area 
wise. You can choose a specific area that you want to generate reports for or generate one consolidated 
report for all areas that you have access to.

RoboHelp Server reports as per area helps you know:
• The frequency and path of user search.
• Key areas that need to be updated/enhanced on priority.
• The location where users seek assistance and make repeated requests.
• Find questions asked by users, and which of them are left unanswered.

NOTE: 
A progress bar will be displayed with the message “Contacting RoboHelp server” when there is a delay 
in fetching reports. 
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Available reports

Not Viewed Topics
Lists the topics in the selected area/areas, that have not been viewed by the users in the selected period 
of time. Use the Not Viewed Topic list to: 

- Display the results in a table with details about file name, project, project area, and server file path.

- Additional columns can be added by clicking on Add/Remove Columns icon to the top right of the 
table.

Search Terms with No Results

Search terms that returned no results and the number of times that users searched for them. Use the 
Search terms with no results to:

- Check the terms which users are seeking information.

- Display the frequency of search term.
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Frequently Searched Terms
Lists the most frequently entered search terms. Useful in identifying areas of an application that may 
require reworking / redesign. Use the Frequently Searched Terms list to:

- Display additional detail displayed when the mouse is hovered over a search term.

- Configure the report’s detail columns.

- With the report’s detail columns, they can be configured to display further feedback analytics data by 
selecting data columns from a list.
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OS statistics
Lists the usage of most preferred operating system used by the end users. This is useful to identify the 
popular operating system for better optimization. Use the OS statistics list to: 

- Display the usage trend of Operating System to view the help file as a bar or pie chart.

- Display the number of sessions used to view content in an Operating System.

Browser statistics
Lists the browsers used to search content. This is helpful in tracking the preferred trend of browser 
usage. Use the Browser statistics list to: 

- Display the usage of web browsers used to search the help content as a bar or pie chart.

- Display the requests in percentage as per the browser usage.
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Pages per visit
Displays the number of pages visited by a user within a browsing session. This is displayed as an 
average of total number of page views divided by the total number of visitors on a given day. Use the 
Pages per visit to: 

- Display the average pages per visit as a function plot graph.

- Display reports on a weekly basis over a particular period.
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Page views
Displays the count of page views received for different pages in the help system. This helps in analyzing 
the performance of the content and do a timely review of pages with lesser number of views. Use the 
Page views to: 

- Display the total number of views for each page in the help file as a function plot graph.

- Display reports on a weekly basis over a particular period.

Frequently Viewed Topics
Lists the most frequently viewed topics. Like the frequently searched terms report, this is useful in iden-
tifying troublesome areas. Additionally it can be a useful indication of how many end users are using 
new functionality. Use the Frequently Searched Terms list to: 

- Display the detail of the feedback analytics below the bar chart.

- Configure the report’s detail column.
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Usage Statistics

Chronological graphical report of the number of hits to the Help system as a whole. Pages searched for 
and not opened reflect in this list. The usage statistics report has four additional tabs.

- Page Views

Number of pages viewed over a given window of time. The window of time is determined by the labels 
along the X axis.

- Pages Per Visit

Number of pages viewed per visit. Every instance when a user opens the project is considered as a 
separate visit. Visits from different Web browsers are counted separately.

- Browser

Comparative data about the Web browsers in which users viewed the Help content.

- OS

Comparative data about the operating systems on which users viewed the Help content.
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Search Trends

The percentage of search terms that returned no results. The detailed view of this report gives the total 
number of search terms and how many of them returned results/no results. Use the Search Trends list 
to:

- Color-coded representation for searches with results and those with no results.

- The option to suppress the report detail.
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Help System Errors

Error messages encountered by the current logged-in user. Use the Help System errors to:

- List all the errors faced by the user when accessing the help system.

- Track missing map id’s, invalid or missing window definitions.

NOTE: 
You can filter any report by area or view a consolidated report for all areas. 

Frequently Used Dynamic Filters
Lists the dynamic filters that end users use most often to generate personalized content. Use the 
frequently Used Dynamic Filters list to:

- Display additional detail displayed when the mouse is hovered over a search term.

- Configure the report’s detail columns.
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View reports

1) In the Web Administrator, click Reports.
2) On the Reports page, select a report and click View Report.

NOTE: 
To fetch fresh report data from the server, click Reload. 

Customize reports

Customizing reports facilitates easier viewing and interpretation. Options selected for customized reports 
remain the same while switching report types. Some useful options that you can specify while viewing 
reports are as follows: 

Area
Instead of viewing a consolidated report for all areas, you can filter the report by area. Viewing 
area-specific reports facilitates interpretation.

Report
Use the drop-down to switch to a different report.

Save as SVG/Save as PNG
Click the three dots beside the Bar chart/Pie chart options in the report area to save the report data as 
a SVG or PNG file.
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Export as CSV/Export as JSON
Click the three dots at the bottom-right corner of the report area to export the report data as a CSV or 
JSON file.

Add/Remove Columns
Click the Wrench icon to add/delete available columns from the data table in the bottom-half of the 
report screen.

Max Results
Use the up and down arrow buttons to display the number of reports of your help content that you 
want to view within a page. The maximum results that can be displayed are 99999 (Ninety-nine thou-
sand, nine hundred ninety-nine) reports.

Date Range
Filter the report by time window.

View Report
Fetch the required report data from the RoboHelp Server by clicking on View Report.

Bar Chart/Pie Chart
Use the radio buttons to display report as a Bar Chart or a Pie Chart. Alternatively, you can choose to 
display the reports by selecting the options in View as:

Graph and Table To view both the visual and data representation of reports.

Table To view only the data in case of displaying numerous reports.

Graph To view only the chart for a pictorial representation of reports.

Access context-sensitive Help

Using context-sensitive Help, you can associate context IDs with topics. Using CSH API, you can retrieve 
topics associated with a given context ID from the server. You can use the CSH API of the server to call a 
context-sensitive Help topic from Responsive HTML5 projects in RoboHelp HTML. You can access CSH for 
Responsive HTML5 projects from the CSH tool and the browser window.

Using the CSH tool, specify a URL and Map Number as follows: 
• For Responsive HTML5, specify 

http://<server-name>:<port-number>/<context-name>/server?project=<proj
ect name>&area=<area-name>&type=<type-of-output> in the Help URL and context ID 
in the map number.

To access context-sensitive Help using the browser window: 
• Specify the URL as 

http://<server-name>:<port-number>/<context-name>/server?project=<proj
ect name>&ctxid=<ctx id>&type=<type-of-output>&area=<area-name> for 
Responsive HTML5 projects.
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You can use CSH API to access Help using a topic name. Enter the URL 
http://<server-name>:<port-number>/<context-name>/server?project=<project 
name>&tpc=<relative topic path>&area=<area-name>[&type=responsivehelp]

REST web services

The REST web services enable you to perform a search on the content and return results for the 
context-sensitive Help. Using the REST services, you can send GET and POST requests to the RoboHelp 
server and get results in the JSON format.

When you install RoboHelp Server 11, some sample project files are stored at Program 
files/Adobe/Adobe RoboHelp/CSH API/RoboHelp.NET/[sample folder name].

RoboHelp Server provides sample files in four languages: Visual Basic, VC++, C#, and JavaScript. All the 
sample files in different languages, other than JavaScript, are stored in different folders. For example, a 
Visual Basic folder is named Sample_RoboHelp_CSH_VB. All the language-specific sample folders also 
contain solution files (.sln files) to open and run them in Visual Studio. Using these samples, you can 
perform search on the projects published on the RoboHelp Server. The result of the query is responded in 
XML format. You can use the results to be displayed in different formats or for scripting purposes. In the 
samples, the search results are displayed in a table format. The columns display rank, topic title with total 
count, the URL, and the summary links to the relevant topics of the specified project.

Send a search query to RoboHelp server

• Public area
When you send a search request to a public area, use the HTTP GET method. You can use the following 
format for your search query:
URL: 
http://<server-name>:<port-number>/<context-name>/rest/search?project=
<project-name>&area=<area-name>&quesn=<search-query>&type=<type-of-out
put>

The server sends the response in the following JSON format:

{ 
   "topics": [ 
      { 
         "strSummary": "{summary}", 
         "strTitle": "{title}", 
         "nIndex": "{index}", 
         "strUrl": "{url}", 
         "strBreadcrumbs": "{breadcrumbpath}", 
         "fRanking": "{rank}", 
         "nTopicId": "{topicId}" 
      } 
   ], 
   "clientIndex": "{isClientsideIndexing(boolean)}", 
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   "syns": "{synonyms}" 
}

• Protected area
To send a query request to a protected area, use the HTTP POST method. Use the following format for 
your search query:

URL : " 
{ 
   "rest": { 
      "uid": "admin", 
      "pwd": "admin", 
      "prj": "mars", 
      "quesn": "topic", 
      "area": "classic", 
      "type": "responsivehelp" 
   } 
}"

For the query request to a protected area, enter a Request body. 

"{    ""topics"": [        {            ""strSummary"": "{ 
   "summary" 
}",            ""strTitle"": "{ 
   "title" 
}",            ""nIndex"": "{ 
   "index" 
}",            ""strUrl"": "{ 
   "url" 
}",            ""strBreadcrumbs"": "{ 
   "breadcrumbpath" 
}",            ""fRanking"": "{ 
   "rank" 
}",            ""nTopicId"": "{ 
   "topicId" 
}"        }    ],    ""clientIndex"": "{ 
   "isClientsideIndexing(boolean)" 
}",    ""syns"": "{ 
   "synonyms" 

The RoboHelp server sends the response in the following format:

"{    ""topics"": [        {            ""strSummary"": "{ 
   "summary" 
}",            ""strTitle"": "{ 
   "title" 
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}",            ""nIndex"": "{ 
   "index" 
}",            ""strUrl"": "{ 
   "url" 
}",            ""strBreadcrumbs"": "{ 
   "breadcrumbpath" 
}",            ""fRanking"": "{ 
   "rank" 
}",            ""nTopicId"": "{ 
   "topicId" 
}"        }    ],    ""clientIndex"": "{ 
   "isClientsideIndexing(boolean)" 
}",    ""syns"": "{ 
   "s

 NOTE: 
To perform a search, you must have project viewing access to that area as a user. If you specify incorrect 
credentials or if you do not have access permissions, the server sends an error response in the XML 
format. 

Search

1) Double-click a solution file from \\Program files\Adobe\Adobe RoboHelp\CSH 
API\RoboHelp.NET\[sample folder name].

2) Language-specific code displays in Visual Studio.
3) Run the code. A language-specific sample project executable file opens. For example, for Visual Basic 

code, the CSH_VB_Sample dialog box appears.
4) To perform search, specify the URL as http://<server-name>/<context-name>/rest.
5) Specify the project name.
6) Enter a search keyword in the Question box.
7) Specify an area, in which the project is published, general or otherwise.

NOTE: 
If you do not specify an area, the default area, general is selected. 

8) Select Responsive HTML5(which specifies the type of project).
9) Click Search.

The search results are displayed in a table format that lists the rank, topic title with total count, URL, and 
summary of the relevant topics of the specified project.
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Legal notices
For legal notices, visit the Legal Notices page.

http://help.adobe.com/en_US/legalnotices/index.html
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